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Prólogo 

 
Este manual nace para ayudar a los compañeros de la Asociación 

Valenciana de Astronomía. El software, que explica este manual, es muy 

potente para manejar nuestros telescopios y cámaras, para obtener 

aquello que buscamos de una forma lo más económica y sencilla posible. 

 

No pretendo complicar el manual, y busco una fórmula para explicar lo 

más simple posible algunas de las funciones de este programa. 

 

En mi caso, al menos de momento, no dispongo de un observatorio fijo 

por lo que en varias de las funciones del programa no entraremos en 

detalle y no las desarrollaré en profundidad porque no lo he probado. 

 

Como nos basamos en mi experiencia con el software, utilizaremos para 

la resolución del campo PlateSolve2 y para el Guiado PHD2. 

 

La última versión disponible del Software cuando se confecciona este 

manual es la versión 3.1.0.457  

 

Este manual está realizado por Joan Josep Isach Cogollos y va dedicado 

a Sandra, mi compañera de viaje. Sin ella no habría llegado hasta aquí. 
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1.- Introducción Sequence Generator Pro 

 

1.1.- ¿Qué es? 

Es un Software dedicado exclusivamente al campo de la fotografía astronómica.  

Este nace según sus creadores por la frustración que, a veces, sufrimos los 

aficionados de este campo para hacer funcionar todo el equipamiento en 

conjunto. 

Con Sequence Generator Pro podemos: 

• Usar y guardar eventos de secuenciación complejos (lights, darks, bias, flats, 
ruedas de filtro, bining, etc.). 

• Crear y guardar perfiles de equipos para que la generación de secuencias 
sea rápida y fácil. 

• Crear secuencias complejas para múltiples objetivos en la misma secuencia. 
• Moverse automáticamente entre objetivos. 
• Automatizar la ejecución de rutinas de autoenfoque de acuerdo con los 

disparadores definidos por el usuario (lo mantiene enfocado a medida que 
baja la temperatura ambiente). 

• Definir disparadores de pausa de secuencia para el enfoque manual (tiempo, 
intervalos, etc.). 

• Interpolación (dither) entre cuadros. Podemos elegir entre tres programas de 
autoguiado (PHD, Astroart y MetaGuide). 

• Centrar el telescopio compatible con ASCOM en cualquier marco de 
referencia que pueda resolver con una placa (¡incluso imágenes de Internet!). 

• Centrado de imágenes ... ¡hace que el encuadre en el cambio de meridiano 
y sesiones de imágenes de varias noches sea muy fácil! 

• Centrar el telescopio compatible con ASCOM en cualquier área de la imagen 
con un solo clic de un mouse. 

• Realizar fácilmente rutinas de encuadre y enfoque (con soporte para cámaras 
de alta velocidad de subtramas). 

• Interfaz de usuario altamente personalizable (arrastre, acople y flote módulos 
pequeños para casi cualquier función). 

• Más de una docena de módulos de IU configurables (gráficos PHD, imagen 
panorámica y zoom, control TEC y más). 

• Rutinas de enfriamiento y calentamiento TEC definidas por el usuario (para 
minimizar el estrés térmico en los componentes sensibles de su cámara). 

• Compensación de temperatura entre cuadros (y entrenador integrado). 
• Crear fácilmente secuencias de "Flats" a partir de una secuencia de "lights". 
• Calibrar automáticamente la duración de exposición de los flats por filtro. 
• Realizar un cambio de meridiano automatizado. 

 

Otros beneficios: 
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• Durante la ejecución de la secuencia, debería poder ajustar casi todos los 
parámetros en tiempo real. 

• Debería poder crear secuencias "fuera de línea". Es decir, no debería 
necesitar conectar el equipo para crear secuencias para su uso posterior.  

  

1.2.- Dónde Obtener SGP 

Disponemos de 2 Versiones del Software: la versión LITE que es gratuita y sólo 

permite crear secuencias, pero ni siquiera se pueden guardar, y la PRO, con 

todas las funcionalidades operativas con un precio de 99 Dólares. 

Podemos comprar el software aquí: https://mainsequencesoftware.com/Store 

 

1.3.- Requisitos previos a la instalación 

• ASCOM 6.2 o superior. Si aún no lo ha hecho, instale ASCOM ( http://ascom-
standards.org/Downloads/Index.htm ) 

• Microsoft .NET 4 Framework ( http://www.microsoft.com/en-
us/download/details.aspx?id=17851 ). Esto debe instalarse automáticamente 
cuando se instala SGPro. 

• Si bien SGPro no depende técnicamente de un guiador automático, es casi 
seguro que usará uno. PHD2 es una guía automática gratuita, de código 
abierto y compatible con la comunidad:   http://openphdguiding.org/ 

 

 

 

 

 

 

 

 

 

 

https://mainsequencesoftware.com/Store
http://ascom-standards.org/Downloads/Index.htm
http://ascom-standards.org/Downloads/Index.htm
http://ascom-standards.org/Downloads/Index.htm
http://www.microsoft.com/en-us/download/details.aspx?id=17851
http://www.microsoft.com/en-us/download/details.aspx?id=17851
http://openphdguiding.org/
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2.- Descripción del entorno de trabajo. 

A continuación, vemos cómo sería abrir el programa por primera vez: 

 

Vemos en la parte superior, su barra de menús y de herramientas, en el lateral 
izquierdo tenemos los Docking modules anclados y sin anclar. Si miramos un 
poco más a la derecha en este ejemplo vemos la ventana de secuencia, que en 
la imagen es la ventana más grande y finalmente, en la parte inferior, vemos la 
barra de estado. 

2.1.- Barra de Menú 

En la barra de menús, están todas las opciones básicas del software como en 

cualquier otro. 

 
 

En File podemos: 

• Crear nueva secuencia o crear nueva secuencia eligiendo un perfil 

concreto de nuestro equipamiento.  

• Abrir una secuencia grabada anteriormente o abrir una imagen del disco 

duro. 

• Grabar la secuencia actual, grabar la secuencia actual como, grabar la 

secuencia actual con un perfil concreto de equipamiento. 

• Aplicar a nuestra secuencia actual un perfil determinado de nuestro 

equipamiento. 

• Importar Objetivos desde otro software, astro planner etc…. 

• Salir del programa. 
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Menú View: 

• Mostrar u ocultar la ventana de secuencia. 

• Mostrar u ocultar el panel de control. 

• Mostrar Ventana grande del estado de la secuencia. 

• Abrir los módulos de acoplamiento (docking modules), dentro de esta 

opción podemos resetear la posición de dichos módulos para volverlos a 

acoplar a los lados. 

• Mostrar u ocultar la barra de tareas. 

• Mostrar u ocultar la barra de estado. 

 

 

Menú Sequence: 

• Resetear secuencia: el progreso de la secuencia se resetea y se perderá 

el progreso. Cuando indicamos que se resetea la secuencia, queremos 

decir que cuando le demos a run empezaría todos los pasos de la 

secuencia desde el principio, resolver el campo, autoenfoque, etc. 

• Resetear secuencia preservando el progreso: la secuencia se resetea, 

pero no perderemos el proceso de nuestras tomas. Es decir, si llevamos 

15 de 50 fotos no se pondría a 0. 
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• Solo resetear la secuencia del objetivo seleccionado en nuestra 

secuencia. 

• Resetear el evento actual de la secuencia: solo reiniciamos el evento 

actual, no todos los del objetivo. 

• Ejecutar las opciones de finalizar la secuencia ahora, para finalizar la 

secuencia. 

• Podemos manejar las imágenes de referencia de secuencias, eliminarlos, 

abrirlos etc. La característica se integra estrechamente con el Asistente 

de enmarcado y mosaico. Cuando cree una secuencia con esta 

herramienta, podrá guardar el lienzo de trabajo como punto de referencia 

• Borrar la caché del navegador 

 

 
 

Menú Tools: 

• Gestor del perfil del equipamiento. Importante: aquí es donde le 

indicaremos qué telescopio, cámara etc. tenemos. 

• Gestor del perfil del usuario: quiénes somos, lugar en coordenadas de la 

captura de las tomas etc. 

• Abrir el asistente de Flats, donde podemos añadir a nuestra secuencia los 

flats y podemos configurar si queremos hacer una pausa en la secuencia 

antes de hacer los flats etc. 

• Flats wizard Calibration, para calibrar nuestros flats (tiempo de exposición, 

filtros, ADU’s etc). 

• Entrenador de compensación de temperatura (viene con instrucciones). 

Sirve para calibrar nuestro enfoque automático para que pueda 

compensar automáticamente si cambia la temperatura ambiente. 

• Grade Image: podemos revisar las imágenes y marcarlas como buenas o 

malas tomas.  

• Podemos habilitar o deshabilitar el historial de imágenes, con datos como 

enfoque, estrellas posición de enfoque, temperatura etc. 

• Asistente para encuadre y mosaico: lo explicaremos más adelante. Es 

importante para encuadrar los objetos en nuestras fotos. 

• Configuración de notificaciones externas, para que, por ejemplo, si 

perdemos la estrella guía nos avise mediante un email. 

• Conectar todo el equipamiento. 
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• Desconectar todo el equipamiento. 

• Herramienta de migración desde la versión 2.5 de SGP. 

• Opciones: podremos cambiar opciones generales, opciones de la 

secuencia, aplicaciones externas. 

 

 

 

Menú Window: 

• Solo podemos cerrar todas las ventanas. 

 

Menú Help: 

En este menú tenemos muchas cosas, pero realmente solo nos interesan 3, para 

este manual básico. 

• Help File, para el manual de ayuda 

• Check for Updates: aunque el programa al arrancar te avisa, si cierras la 

ventana de actualización desde aquí podemos ver si hay e instalarlas. 

• Register this Machine, para introducir los datos de licencia y registrar el 

pc, y así poder usar todas sus funcionalidades 
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Utilizaremos nuestros datos de registro -email y la contraseña- y pulsaremos en 

Register. Podemos resetear la contraseña o administrar las licencias si tenemos 

conexión a internet desde esta misma ventana. 

 

2.2.- Barra de Herramientas 

Es la barra de accesos rápidos a ciertas opciones del menú y a los Docking 

Modules. 

 
Por orden, de izquierda a derecha: 

• Crear nueva secuencia, o si pinchamos en el triangulito, crear nueva 

secuencia con un perfil determinado. 

Abrir imagen o abrir capeta de imágenes. 

• Guardar la secuencia, como en el word. Si no está guardada y pulsamos, 

guardará un archivo nuevo, pero ¡cuidado! si ya está guardado y volemos 

a pulsar sobrescribe sin preguntar. 

• Mostrar /Ocultar Secuencia. 

• Panel de control: si necesitamos cambiar alguna configuración solo para 

esta secuencia, sin que se quede guardada, lo haremos desde aquí y no 

cambiaremos nada en equipament profile. Viene muy bien para cuando 

hacemos pruebas. 
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A partir de aquí son Docking modules. Si ya está abierto y anclado, o solo abierto, 

este no se abrirá si lo pulsamos desde la barra de herramientas porque ya estaría 

abierto. 

• Histograma de la imagen 

• Estadísticas de la imagen 

• Desplazarse y hacer zoom 

• Secuencia: vemos el porcentaje completado de la secuencia 

• Frame & Focus: para hacer tomas para enfocar 

• Filter wheel: muestra y permite cambiar el filtro que tenemos puesto en la 

rueda portafiltros 

• Control de enfoque 

• Gráfico de guiado de PHD2 

• Temperatura de la cámara 

• Telescopio: información de la posición, tiempo hasta el cambio de 

meridiano, etc. 

• Observatorio 

• Rotador 

• Caja de Flats 

• Marcadores de destino 

• Centrado del telescopio: para resolver y sincronizar etc. 

• Ver Opciones 

• Historial de imágenes 

• Datos del entorno 

• Bloqueo de enfoque. 

2.3.- Barra de Estado 

La barra de estado se encuentra en la parte inferior de la ventana del programa 

y nos muestra información. 

En el lado izquierdo nos muestra qué está realizando el programa; en el ejemplo 

nos dice que está preparado 

 

Nos indicará en este apartado todo lo relativo a lo que está haciendo, 

encendiendo el autoguiado, cuando hacemos el dithering, el tiempo que lleva la 

toma actual etc.…. 

En el lado derecho nos da más información: 

 

Si tenemos activo el auto foco, si tenemos activada la opción de recordatorio de 

enfoque automático, y si tenemos activado la compensación de temperatura en 

el autoenfoque.  
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También nos indica si tenemos activados el auto centrado/seguimiento del 

objetivo y si tenemos activado el planing tools (para programar el arranque y la 

finalización de la secuencia).  

En cuanto al telescopio, nos marca si tenemos activado el Park del teslescopio 

cuando finalice la secuencia, el cambio de meridiano automatico y nos muestra 

el tiempo que falta para dicho cambio.  

Nos indica información sobre el guiado, si esta activado el dither, si tenemos 

activo que reinicie la toma si el guiado se va fuera de rango y si tenemos activado 

que pare el guiado cuando acabe la secuencia.  

Por último vemos si tenemos activados las opciones de Recovery y Safety. La 

primera es para que si falla la secuencia por una nube, cada x tiempo reintente 

reinciar la secuencia. Para el safety es necesario disponer de estación 

meteorológica, sirve para cerrar el obeservatorio y que continue si las 

condiciones lo permiten.  

 

2.4.-Barras laterales y Docking Modules 

Hemos comentado ya que los Docking modules se pueden anclar. Pues bien, en 

el lado izquierdo de la ventana del programa tenemos un ancho reservado para 

dejar anclados estos módulos para tenerlos a mano siempre abiertos. 

Aunque cuando abrimos por primera vez el SGP no aparece ningún módulo 

anclado en el lado derecho, también podremos anclar dichos módulos en este 

lado. 

Cómo se anclan es muy sencillo: abrimos el módulo deseado desde view -> 

Docking Modules 

Si no estaba abierto ya, se abrirá una nueva ventana, seleccionamos con el con 

el botón izquierdo del ratón donde está el título del módulo y arrastramos a 

derecha o izquierda, según nos convenga. Aparecerá algo como la siguiente 

imagen si no hay ningún módulo anclado y soltaremos en el icono para anclarlo 

 

Si por el contrario, en la barra lateral ya tenemos otro módulo anclado, al arrastrar 

el módulo nos saldrán 3 posibilidades: 
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Con el icono de en medio, añadiremos el módulo como una pestaña más. 

Si, por el contrario, elegimos la primera opción nuestro módulo se situará arriba 

del módulo situado en la barra lateral hasta donde hemos arrastrado el nuestro. 

De la misma forma si optamos por la última opción nuestro módulo se pondrá 

debajo. 

Para cerrar un módulo anclado, lo seleccionamos y pulsamos en la X para 

cerrarlo. 

 

 

Desde la opción del triangulito  de los módulos anclados, podemos acceder 

como un menú rápido a la configuración del panel de control. Recuerda que 

cualquier cambio realizado en el panel de control solo sirve para la sequencia en 

curso. 
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2.5.- Ventana de Secuencia 

 

 
La Ventana de secuencia tiene el nombre de la secuencia en la parte superior, y 

se compone de varios bloques. 

Bloque de objetivos (Target) 

En este aparado tenemos ordenados el o los objetivos a fotografiar.  

Podemos poner varios y marcar o no la casilla que aparece a la izquierda de 

cada nombre para que en esta secuencia lo fotografiemos o no. 

 

Si la secuencia está en marcha y está trabajando el SGP con ese objetivo, en 

lugar de un símbolo de pausa aparecerá un símbolo de play. 
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La tuerca que aparece si pasamos con el ratón sobre el objeto son las Opciones 

del Objetivo y las explicaremos en el punto 5 de este manual. 

En la parte inferior aparecen las opciones para añadir objetivo con el símbolo +, 

mover arriba o abajo para cambiar el orden de los objetivos con las flechas arriba 

y abajo, eliminar objetivo con el símbolo X y cambiar las opciones símbolo -. 

Dentro de las opciones podemos: 

• Disparar los darks, bias, flats cuando falla la secuencia 

• Finalizar la secuencia tras unas horas determinadas 

• Desconectar todo el equipamiento cuando finaliza la secuencia 

• Ejecutar un script 

• Reanudar después de que vuelva a modo seguro 

 

 

Por último, en esta parte tenemos opciones ocultas. Para verlas podemos 

seleccionar uno de los Objetivos y pulsar el botón derecho del ratón y estas 

aparecerán. 
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Como podemos observar, aparecen opciones para  seleccionar todos, quitar la 

selección, duplicar el objetivo, eliminarlo, resetear el progreso, copiar eventos 

entre objetivos, etc… 

 

Bloque Datos de Secuencia 

En este apartado vemos: 

• Qué objetivo se está ejecutando; si no, aparecerá None 

• La carpeta donde se van a guardar las imágenes 

• El formato del nombre del archivo 

• El perfil del usuario elegido 

• Datos del progreso de la secuencia del objetivo. 

 

Explicaremos el formato del nombre del archivo más adelante cuando entremos 

en detalle en equipment profile. 

 

Bloque Equipamiento 

En este apartado aparecerá nuestro equipo y si está conectado o no. Si algo falla 

también podemos configurarlo desde este aparado. 

En este aparado no configuraremos el equipo ya que lo realizaremos en 

equipament profile para hacerlo solo una única vez. 

Normalmente realizaremos pocos cambios aquí, como por ejemplo ajustar el 

Gain de la cámara, indicar si es una CMOS -como las ASI ZWO o las QHY 

CMOS-, y el puerto COM de la montura, si este ha cambiado porque hayamos 

cambiado el puerto usb al que la acostumbramos a conectar. 

El icono de la llave inglesa es para cambiar la configuración, y el icono gris es 

para conectar el dispositivo. 
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Acontinuacion vemos el bloque desplegado: 

 

Bloque de Eventos 

 

Este bloque es el que realmente secuencia nuestras tomas. Aquí podemos dividir 

en eventos nuestras tomas, por ejemplo: 

Evento 1, tomas light, filtro L, 300s de exposición, bin 1x1, 30 tomas 

Evento 2, tomas light, filtro R, 180s de exposición, bin 2x2, 15 tomas 

Evento 3, tomas light, filtro G, 180s de exposición, bin 2x2, 15 tomas 

Evento 4, tomas light, filtro B, 180s de exposición, bin 2x2, 15 tomas. 

Agregar nuevo evento (Add New Event): 

 

Para agregar un nuevo evento, navegue hasta la esquina inferior izquierda del 

secuenciador y haga clic en Add New Event ("Agregar nuevo evento") 

Opcionalmente, puede hacer clic en la flecha pequeña a la derecha y agregar un 

nuevo evento que sea una copia de otro evento existente 
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Iconos de eventos y acciones 

 

• Eliminar evento (icono "X"): Al hacer clic en este botón, se eliminará 

permanentemente el evento. No puede eliminar un evento que pertenece a un 

objetivo que se está ejecutando actualmente. 

• Reordenar evento (iconos de flecha): use estas flechas para reordenar 

eventos en un objetivo (afecta el orden de ejecución). No puede reordenar un 

evento que pertenece a un objetivo que se está ejecutando actualmente. 

• Indicador de pausa (icono de pausa): este indicador se "encenderá" si el 

evento contiene una instrucción de pausa previa o posterior (consulte 

Configuración de evento a continuación en el manual de ayuda de SGP). Los 

puntos sobre el icono son representativos de pre y post. Si este icono se 

ilumina junto con el punto izquierdo, indica una pausa previa al evento. 

• Indicador de estacionamiento (icono del telescopio): este indicador se 

"iluminará" si el evento contiene una instrucción previa o posterior al 

estacionamiento (consulte Configuración de evento a continuación en el 

manual de ayuda de SGP). Los puntos sobre el icono son representativos de 

pre y post. Si este icono se ilumina junto con el punto izquierdo, indica un 

parque previo al evento. 

• Indicador de secuencia de comandos (iconos de secuencia de comandos) : 

este indicador se "encenderá" si el evento contiene una instrucción de 

secuencia de comandos previa o posterior (consulte Configuración de evento 

a continuación en el manual de ayuda de SGP). Los puntos sobre el icono son 

representativos de pre y post. Si este icono está iluminado junto con el punto 

izquierdo, indica un guión previo al evento. 

• Notificaciones de eventos (icono de globo de diálogo): si el evento contiene 

notificaciones, este icono se "iluminará". Estas notificaciones normalmente 

contienen algún tipo de información indicativa de un error de evento. Consulte 

la sección a continuación denominada "Notificaciones de eventos" en el 

manual de ayuda de SGP para obtener más información. 

• Opciones de evento (icono de engranaje): al hacer clic en este botón se 

mostrará el menú contextual del evento (consulte la sección a continuación en 

el manual de Ayuda de SGP para obtener más detalles). 
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Usando el menú contextual anterior, se pueden realizar una variedad de 
operaciones de copia de eventos: 

• Copiar desde: copia la configuración del evento desde otro evento. 
• Copiar a: copie la configuración de eventos de este evento a uno o más 

eventos (marque al lado de cada evento objetivo y luego seleccione los 
campos que desea omitir de la operación de copia): 

 
 
 

• Restablecer progreso: esta acción restablecerá el progreso de este evento a 
cero. 

• Editar progreso: Edición personalizada del número de fotogramas capturados 
(progreso). 

• Establecer como evento actual: esta acción establecerá el evento 
seleccionado como el evento actual. Esto significa que cuando comienza o 
reanuda una secuencia, la está obligando a comenzar en este 
evento. Después del inicio, la secuencia continuará seleccionando el trabajo 
normalmente . La configuración del evento actual solo se puede realizar 
cuando no se está ejecutando una secuencia. 

 

 

https://mainsequencesoftware.com/Content/SGPHelp/HowtheSequenceSelectsWork.html
https://mainsequencesoftware.com/Content/SGPHelp/HowtheSequenceSelectsWork.html
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Configuraciones de eventos 

 

 

Cada evento tiene un conjunto de opciones asociadas que pueden modificar el 

comportamiento de la secuencia tanto antes como después de que el evento se 

inicie o se complete. 

Park Telescope: si esta opción está marcada, el telescopio se estacionará 

cuando el evento comience (pre) o finalice (post). 

Pause Sequence: si esta opción está marcada, la secuencia se pausará cuando 

el evento comience (pre) o finalice (post). Cuando está en pausa, se mostrará un 

cuadro de diálogo que contiene el texto "Mensaje". 

• Ejecutar enfoque automático al reanudar: si esta opción está marcada, la 

secuencia forzará la ejecución automática cuando el usuario reanude. 

• Recordatorio de enfoque manual al reanudar: si esta opción está 

marcada, la secuencia forzará un diálogo de recordatorio de enfoque 

manual cuando el usuario reanude. 

Run Script (ejecutar script): esto le permitirá ejecutar un script VBS o EXE creado 

por el usuario cuando el evento comience (pre) o finalice (post). Tenga en cuenta 

que la secuencia no continuará hasta que se complete el guión. SGPro utiliza el 

motor VB "cscript" de Windows. Esto significa que no puede usar elementos de 

interfaz wscript (es decir, ventanas y cuadros de diálogo). Todo en su script debe 

estar diseñado para ejecutarse en la línea de comando. Consulte la 

documentación de Windows cscript aquí . Si su secuencia de comandos se 

bloquea o nunca se completa (se cierra), la secuencia se bloqueará con ella ... 

Other Options (otras opciones):    

• Event Gain: si su cámara admite ganancia, puede configurar la ganancia 

por evento aquí. Si esto no está configurado (y su cámara admite 

ganancia), SGPro utilizará la ganancia basada en binning predeterminada 

definida en el panel de control . 
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• Event Offset (compensación de evento): si su cámara admite 

compensación, puede configurar la compensación por evento aquí. Si 

esto no está configurado (y su cámara admite compensación), SGPro 

utilizará la compensación proporcionada en el controlador de su cámara. 

Reset Progress (Restablecer evento): esto restablecerá el progreso del evento 

(no sus opciones o configuraciones). 

 

Tipo de toma 

Aquí en el desplegable Type podemos elegir si nuestras tomas son: 

 
Eventos Light 
 

 
 

Las tomas de nuestro objetivo real. 
 
 

Eventos Dark 
 

 
 

Los eventos Dark -tomas oscuras- se utilizan para capturar tomas de calibración 
oscuras. No requieren el uso de un filtro, pero deben tomarse en un entorno que 
no permita que la luz golpee el CCD. Además, la mayoría de los darks se toman 
con la misma duración y temperatura de exposición que las tomas light 
correspondientes (algunas aplicaciones de procesamiento pueden escalar los 
darks a cualquier longitud de exposición). Es recomendable construir una 
biblioteca (de modo que no necesite realizarlos en cada sesión de imágenes). 
 
 

Eventos Bias 
 

 
 

Los eventos de Bias se utilizan para capturar tomas de calibración de ruido de 
lectura de la cámara. No requieren el uso de un filtro, pero deben tomarse en un 
entorno que no permita que la luz golpee el CCD. Además, la mayoría de los 
cuadros de polarización se toman con el tiempo de exposición mínimo permitido 
(establezca el tiempo de exposición en 0).  Es recomendable construir una 
biblioteca (de modo que no necesite realizarlos en cada sesión de imágenes). 
 
 

Eventos Flat 
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Los eventos Flat se utilizan para capturar tomas de calibración planas. Estas 
capturas deben realizarse durante cada sesión de imágenes porque dependen 
de la alineación de todo el tren de imágenes. Las tomas Flats normalmente 
apuntan a una ADU (Analog to Digital Unit) media de 22.000 a 25.000, pero esto 
dependerá de la cámara y la preferencia del usuario. Si se definen sus datos de 
Flats (por filtro), al seleccionar un evento de Flats se completará 
automáticamente el tiempo de exposición guardado (para el binning 
seleccionado). 
 

Filter 

En el campo filter elegimos nuestro filtro. Para que en este campo salgan los 

filtros, previamente deben haber sido configurados en equipment profile. 

Exposure 

Tiempo de exposición de nuestras tomas en segundos o minutos. Este 

dependerá de nuestra cámara y del objeto a fotografiar. 

Sufix 

Podemos añadir un sufijo. Este aparecerá en el nombre del archivo. 

Bin 

Campo reservado para que elijamos el bining con el que trabajar. 

Repeat 

Numero de tomas que queremos de cada evento. 

Progress 

 

Progreso de nuestras tomas por cada evento. 

 

También podemos ver el tiempo que llevamos trabajando y el total restante en la 

parte inferior del bloque de eventos 
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Iniciar una secuencia 

 

Cuando todo esté correctamente planificado y configurado pulsaremos para que 

SGPro inicie nuestra secuencia. Una vez iniciada el botón cambiará a Pause 

sequence. 

Pausar la secuencia 

Podemos parar la secuencia sin perder la toma que estamos realizando. SGP 

esperará a que acabe para pausar la secuencia.  

 

 

 

O bien podemos parar abortando la toma actual, con lo que perderemos la toma 

en curso. 

 

 

 

Si en cualquiera de las dos opciones anteriores marcamos “Run end of sequence 

options”, según los parámetros que tengamos configurados, cuando finaliza la 

secuencia esta la ejecutará.  

Por ejemplo, si tenemos configurado que pare el guiado y aparque el telescopio, 

al pausar la secuencia parará el guiado y seguidamente aparcará el telescopio. 
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2.6.- Ventana de Imagen 

 

 

Cuando el programa descarga cualquier imagen a nuestro ordenador, este 

dispone de un bloque o ventana dedicado a la imagen. 

En este bloque, mediante diferentes pestañas, podemos ver varias imágenes a 

la vez. En estas pestañas aparece el nombre de la imagen que estamos viendo 

o, por ejemplo, si estamos enfocando, aparece el nombre “Frame and focus” del 

módulo de enfoque. 

 

Si queremos ver, por ejemplo, dos imágenes en la misma pantalla y enfrentarlas, 

tenemos las mismas opciones que disponemos con los módulos. Podemos 

arrastrar la pestaña de la imagen y colocarla a nuestro gusto como en la imagen 

siguiente: 
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Este bloque dispone de su propio menú donde vemos diferentes iconos: por un 

lado, en el lado izquierdo tenemos:  

 

Y en el lado derecho: 

  

Claramente esta opción es para el zoom de nuestra imagen.  

Entremos un poco en detalle: 

• Nuestra secuencia ya tiene varias imágenes. Para avanzar y retroceder 

en ellas de una en una podemos usar  

• Ahora supongamos que la toma que estamos revisando es de mala 

calidad, podemos calificarla como mala (“BAD”). Automáticamente SGP 

le cambiará el nombre a la imagen y añadirá el prefijo BAD delante en el 

nombre de la imagen, para descartarla posteriormente.  

• Es posible aumentar y disminuir el zoom de nuestra imagen.  

• Si hemos hecho zoom y queremos ver la imagen de nuevo ajustada a la 

ventana.   

• Queremos hacer zoom sobre una zona concreta, pulsaremos  y 

seguidamente dibujaremos con el ratón un rectángulo en la zona de 

interés. 

• Botones para rotar la imagen 90º derecha o izquierda o 180º   

• Por último, varias opciones más. Por orden: auto estirar la imagen, invertir 

los colores de la imagen, encender o apagar un retículo el centro de la 

imagen, calcular el HFR de la imagen (se usa para comprobar el enfoque) 

y ver los datos guardados en la cabecera del archivo FIT.  

 
 

Disponemos además de ciertas opciones “ocultas” a primera vista, pero si 

pulsamos con el botón derecho del ratón sobre la imagen, estas aparecerán. 

• Podemos aumentar el zoom 25, 50,100 o 200%. 

• Auto estirar la imagen en diferentes grados: bajo, medio, alto o ninguno. 

• Invertir la imagen, ver la cabecera del fit, mostrar un retículo en la imagen, 

calcular el HFR. 

• Las interesantes: Centrar el telescopio aquí, centrará el telescopio en el 

punto donde hemos hecho el click derecho en la imagen, para ello realiza 

“Plate Solve” para poder centrarlo; Mover el telescopio aquí, no realizará 

un “Plate solve” y moverá el telescopio hasta ahí; por último podemos 

hacer una resolución de campo “Plate Solve”. 
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• Y dos últimas opciones: Guardar imagen como FITS Mono.., permitirá 

guardar la imagen donde tú quieras del disco duro, y la opción Marcar 

como “BAD”. 

 

 

3.- Perfil de Usuario y Perfil de Equipamiento 

Los perfiles son una de las piezas más importantes del uso de Sequence 

Generator Pro. 

El sistema de perfiles le permite caracterizar todo su sistema de imágenes e 

incluso le permite configurar diferentes perfiles para diferentes conjuntos de 

equipos o diferentes configuraciones que se necesitan cuando se intercambia 

una sola pieza. Esto puede ahorrar mucho tiempo y puede evitar la introducción 

de errores si tiene una interacción compleja con el equipo. 

Sequence Generator Pro permite la creación de dos tipos diferentes de perfil, 

Perfil del Usuario y Perfiles de Equipamiento. 

 

3.1.-Gestor del Perfil del Usario 

Los perfiles de usuario almacenan información específica del sitio. Esta 

información se almacena en el encabezado FIT de sus imágenes guardadas. En 

general, esta información es útil para la medición de la astrometría (o incluso 

para la organización personal). 

Para llegar a él debemos ir a Tools→User profile Manager desde la barra de 

Menús o bien puslar Ctrl+U. 
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Seleccionar un perfil como "predeterminado" significa que todas las secuencias 

nuevas usarán automáticamente este perfil. 

Auto Populate: si tiene una conexión a Internet, puede intentar localizar 

automáticamente su posición. Tenga cuidado con esto ... en algún momento la 

geolocalización de Internet no es tan buena. 

En Site Horizon se debe intruducir el límite de nuestro horizonte. Por ejemplo, 

que nuestro telescopio no supere X grados debido a la pared de nuestro 

observatorio. Este apartado a mi entender no es opcional. Si no lo tenemos 

cumplimentado el software no sabrá dónde está el horizonte límite y nos 

mostrará una insistente ventana cada vez que iniciemos una secuencia. 

 

3.2.-Gestor de Perfiles del Equipamiento 

Profile Manager se usa para crear, editar, eliminar y guardar perfiles. Un perfil 

contiene una descripción del hardware y la configuración que luego se utilizará 

para crear secuencias. Una secuencia creada con un perfil lo completará 

automáticamente con todo el hardware y la configuración que se guardaron. La 

única razón por la que existen los Perfiles es para crear secuencias con un 

conjunto de equipos y opciones específicas para su equipo. Los perfiles sin 

secuencias son inútiles, con la excepción del perfil predeterminado, que 

técnicamente crea una nueva secuencia cuando Sequence Generator Pro se 

carga por primera vez (y cuando crea una secuencia "Nueva"). 

Para llegar a él debemos ir a Tools→User profile Manager desde la barra de 

Menús. 

La primera vez que abramos el Equipment Profile Manager, nos aparecerán tres 

plantillas de configuración a modo de ejemplo: Canon Template, LRGB Template 
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y NB Template, donde podemos ver ejemplos de configuración de nuestro equipo 

la primera vez. 

 

El administrador de perfiles se divide en 2 partes principales: A la izquierda está 

el área de selección de perfil, y a la derecha está el área de equipamiento.  

Modificar un perfil o crear uno desde otro. 

El perfil activo quedará marcado con el símbolo * y cualquier configuración 

realizada en el lado del equipo se guardará en ese perfil cuando se haga clic en 

el botón Guardar.  

Por ejemplo, si seleccionamos Canon Template podemos realizar 

modificaciones y al presionar Save se guardará en este perfil. 

Si por el contrario desea crear uno nuevo usando este perfil como plantilla, no 

olvide cambiar el nombre del perfil, escriba un nuevo nombre de perfil en el 

cuadro de texto debajo de "Select or name a profile" antes de darle a Save para 

guardarlo 

Crear un nuevo perfil. 

1. Utilizando las pestañas proporcionadas, seleccione las opciones relevantes 

para su configuración. 

2. Cuando termine, escriba un nuevo nombre de perfil en el cuadro de texto 

debajo de "Select or name a profile". 

3. Haga clic en "Guardar" 

Eliminar un perfil. 
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Para eliminar un perfil, simplemente resalte el perfil y haga clic en el botón 

"Eliminar". 

 

Creando un perfil: configuración del área de equipamiento. 

Esta área dentro de la configuración es igual que el módulo del “Control Panel”. 

A diferencia de este, cuando modificamos o creamos un perfil, los cambios no 

se realizan hasta que no apliquemos el perfil a la secuencia. 

Para ello podemos ir a File→Apply Profile To Sequence, como siempre desde 

nuestra barra de Menús.  

A continuación, veremos las diferentes pestañas. Para nuestro ejemplo de 

configuración usaremos una cámara CCD refrigerada con rueda con 4 filtros: 

 

Camera 

Apartado para configurar nuestra cámara. 

 

 

 

Camera 

 

En el desplegable elegiremos nuestra cámara y en el botón “settings” 

configuraremos nuestra cámara. 
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Dependiendo de las opciones que permita cada cámara, podremos configurar 

desde aquí los parámetros del driver de la misma, gain, offset, tipo de archivo fit, 

raw, etc. 

Esto lo podemos hacer también desde la secuencia con el botón que ya hemos 

visto antes  

Cualquier modificación de este valor quedará guardado en el driver de la cámara 

hasta que volvamos a modificarlo. 

Cooler 

Podemos, indicar la temperatura que queremos alcanzar “Cool Down to” y el 

tiempo que queremos que tarde en llegar. 

Y también el tiempo que queremos que tarde en calentar la cámara “Warm Up” 

y la temperatura a alcanzar de nuevo cuando terminemos la sesión de fotos. 

Como sabéis, para alargar la durabilidad de nuestra cámara no se debe apagar 

de golpe (no es bueno pasar de la temperatura de trabajo a la de apagado 

instantáneamente).  

Con las siguientes opciones podemos automatizar el enfriado y calentamiento 

de nuestra cámara: 

“Cool down on camera connect”: si marcamos esta opción, cuando conectemos 

la cámara automáticamente empezará a enfriarse. 

“Cool Down on sequence start”: en este caso comenzará el enfriado de nuestra 

cámara cuando iniciemos la secuencia. 

“Warn up on sequence compete”: calentará nuestra cámara una vez finalice la 

secuencia. 

 

Para que estás 3 opciones funcionen correctamente cumplimentaremos los 

campos que hemos explicado anteriormente. 

Nota: para cámaras no refrigeradas este bloque es irrelevante. 

 

Gain 

En este bloque podemos indicarle al SGP que tome los datos de gain de la 

cámara o podemos indicarle el valor del gain manualmente medido en e-/ADU 

para cada binning. 
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Personalmente no lo utilizo y no es crítico para la obtención de mis imágenes, 

por lo que dejo los valores por defecto. 

 

Settings and specs 

 

Aquí debemos proporcionar a SGP información valiosa sobre el sensor de 

nuestra cámara y la resolución de esta junto a nuestro tubo óptico. Esta 

información es crítica, por ejemplo, si usamos la herramienta de Framing & 

Mosaic Wizard. 

En “Angle” introduciremos los grados de la posición de nuestra cámara (por 

ejemplo, cuando se encuentra siempre fija en un observatorio). 

“Scale”: resolución de campo de nuestra cámara. Para calcularlo me sirvo de 

esta herramienta http://www.astroerrante.com/principal-utilidades/calculo-

ccd.html, donde debemos poner nuestro tubo óptico y los datos del sensor de 

nuestra cámara. 

“Readout noise”: datos del ruido de lectura del sensor de nuestra cámara. No 

sería un dato crítico si no lo conocemos. 

“Pixels”: por último los datos de la cantidad de píxels que tiene nuestro sensor. 

Este dato sí debemos cumplimentarlo (en las especificaciones de la cámara 

siempre aparecen estos). 

 

Download Times (s) / Options 

El tiempo que tarda nuestra cámara en descargar la imagen a nuestro pc 

separado según el binning. Debemos cumplimentarlo según las especificaciones 

de la cámara. Si no las tienes, puedes calcularlo tú mismo. 

 

Filters 

En esta pestaña configuraremos nuestra rueda porta filtros. Si no disponemos o 

esta es manual podemos seleccionar la manual, para que SGP pause la 

secuencia y puedas cambiar el filtro manualmente antes de continuar la 

secuencia. 

http://www.astroerrante.com/principal-utilidades/calculo-ccd.html
http://www.astroerrante.com/principal-utilidades/calculo-ccd.html
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Filter Wheel 

Desplegable con las ruedas porta filtros disponibles. En “Settings”,  igual que con 

las cámaras, podemos modificar los parámetros del driver de la rueda. 

“Filter change delay (sec)”: tiempo que tarda nuestra rueda en cambiar de filtro 

“Set Filters”: nos abrirá otra ventana donde configuraremos la posición, el 

nombre del filtro, la exposición, el filtro por defecto de enfoque, el punto de 

enfoque para el enfocador automático y la exposición necesaria para realizar los 

Flats. También podemos importar la configuración de los filtros del propio driver 

de la rueda con el botón “Import”. 

Nota: La opción Flats es para aquellos que tienen una caja de flats, ya que en 

este caso las exposiciones son siempre las mismas y por tanto podemos dejarlas 

fijas aquí. Si por el contrario no dispones de esta caja, no cumplimentaremos 

esta configuración. 

 

“Set No Filter Flats Data”: en este botón podemos configurar los valores de 

exposición de nuestros flats, el número de tomas etc. cuando no tenemos filtros 
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Focus 

 

En este aparado seleccionaremos nuestro enfocador, manual en caso de no 

disponer de uno motorizado. 

Focuser 

 

Desplegable con los diferentes enfocadores disponibles instalados en tu 

ordenador. Botón Settings igual que anteriormente para cambiar configuración 

del driver. 

Si elegimos manual, el enfoque lo tendremos que realizar nosotros 

manualmente. Normalmente en este caso enfocaremos antes de iniciar la 

secuencia (explicaremos mediante un apartado propio cómo enfocar 

manualmente con el SGP). 

“Fine focus step size”: cantidad de Steps en el botón “Fine”. Este valor es usado 

por el módulo Focus Control para los movimientos de enfoque fino. Ejemplo: 10 

Steps 

“Coarse focus step size”: igual que el anterior, pero para el botón “Coarse” del 

módulo indicado anteriormente. En este caso los movimientos de enfoque no son 

tan finos. Ejemplo: 100 Steps. 
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“Reverse direction”: como indica es para invertir el movimiento del motor. Esto lo 

podemos hacer desde esta opción o desde el propio driver del motor de enfoque. 

“Focus reminder”: si marcamos esta opción -según nuestro criterio- pausa la 

secuencia para volver a enfocar. Podemos usarlo para enfoque manual. 

Para modificar estos parámetros le daremos a “Set” e indicaremos los criterios 

que sean de nuestro agrado. Por ejemplo, cada X tomas, cada X minutos, etc. 

 

“Use auto focus”: si tienes enfocador automático esta es tu opción. Cuando está 

activada, usará los parámetros que le proporcionemos en Set. Con ella logramos 

gestionar el enfoque automáticamente durante nuestra secuencia. 

Si pulsamos en “Set” podemos introducir nuestros parámetros: 

 

 

Adentrémonos un poco más en las opciones que permite el "Use auto focus”: 
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En el lado izquierdo, en Auto Focus Frequency, tenemos las variables de cuándo 

usar el auto focus. Las enumero por orden: 

• Cada X frames 

• Cuando la temperatura cambie X grados 

• Cada X minutos 

• Usar cuando cambiemos el filtro 

• Cuando iniciemos la secuencia, pero no cuando le demos a Resume si ya 

está iniciada 

• Cuando está pausada y volvemos a iniciarla (resume) 

• Después de la acción de auto centrar 

 

 

 

 

 

Por ejemplo, para mis secuencias yo utilizo esta configuración: 

 

Nota: Cuando nuestra secuencia está en marcha, desde el módulo Focus Control 

podemos pulsar el botón “Run” y cuando finalice la toma que está realizando, 

lanzará un autoenfoque. 

En el lado derecho en Options podemos ajustar lo siguiente, de nuevo en orden: 

• Configurar el tiempo de exposición para filtros o sin filtros. Si no tenemos 

filtros pondremos aquí el tiempo de exposición de nuestra toma para 

poder enfocar.  Si disponemos de filtros, pulsamos sobre “For Filters” y 

desde ahí en “AF Expose” podemos modificar el tiempo de exposición 

para cada filtro (recuerda en la pestaña filters también podemos poner la 

exposición por cada filtro para enfocar). 

• Elegir el bining de la imagen a usar para el auto enfoque. 
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• El número de puntos de enfoque. Cuando SGP enfoca traza una gráfica 

de enfoque; estos serían los puntos de dicha gráfica. Si no la hace bien 

quizá necesites más de 10. 

• Step size, sería los pasos que dará el motor de enfoque entre cada punto 

de enfoque configurado en la opción anterior. 

• Tiempo en segundos en el que aparecerá el cuadro de diálogo del 

autoenfoque tras finalizar este. 

• Seleccionar el diámetro mínimo de las estrellas. 

• Deshabilitar el Smart focus: es usado para telescopios con obstrucción 

central, como los SC. 

• Podemos indicarle que solo use un filtro determinado. Por ejemplo, si los 

filtros son parafocales podemos indicarle que enfoque siempre con el de 

luminancia ya que necesita menos tiempo de exposición y realizaríamos 

el autoenfoque más rápido. 

• Recortar las imágenes que usa para el auto enfoque en % 

• Aplicar a las imágenes de autoenfoque un dark. 

• Guardar las imágenes de autoenfoque en una carpeta del dispositivo. 

Nota: En sus webs algunos fabricantes de motores de autoenfoque nos facilitan 

la tarea de configuración proporcionando un manual para configurar los 

parámetros de Autofocus Data points y step Size de sus motores para SGP. 

A continuación, un ejemplo de configuración: 

 

 

Volvemos a la Pestaña principal de Focus, “Auto adjust focus per filter”. Si 

marcamos esta opción, previamente en la pestaña filters → Set Filters debemos 

tener configurados los puntos de enfoque para cada filtro. El programa pondrá 

dichos puntos, en cada filtro, cuando cambiemos el filtro. En mi caso no la utilizo. 
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“Temperature compensate”: esta opción permite indicarle cuántos pasos debe 

moverse el motor en caso de variar la temperatura por cada grado. No la utilizo, 

ya que en mi configuración si varía 2 grados la temperatura exterior, vuelvo a 

autoenfocar. Para usar esta herramienta es necesario “entrenar” SGP con la 

opción Tools→Temperature compensation Training 

 

Frame and Focus 

Solo hay dos opciones en este apartado. Seleccionaremos el binnig y la 

exposición de nuestras tomas para enfocar. Estos cambios solo afectan al 

módulo de Frame and focus. 

 

 

 

Telescope 

En este apartado configuraremos los parámetros de nuestro telescopio para 

SGP. 

 

En Telescope, seleccionaremos el driver de nuestra montura. Yo trabajo con el 

POTH hub por si necesito usar la montura con otro software. Como hemos visto 

en Settings podemos cambiar los parámetros del driver de la montura. 

Enumeramos las siguientes opciones que nos da, por orden: 

• Aparcar el telescopio cuando acaba la secuencia. Muy útil cuando te vas 

a dormir y lo dejas trabajando para que él solo se aparque. 

• Parar el seguimiento de la montura cuando acaba la secuencia. Si no 

marcas la anterior dejará el telescopio parado donde terminó. 
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• Permite el uso del telescopio desde otras apps, como SkySafari. En mi 

caso no la utilizo. 

• Cambio de meridiano automático. Esta opción, con los valores por 

defecto, realizará un cambio de meridano de forma automatizada. Tienes 

varias opciones más dentro de “Set”, que puedes cambiar a tu voluntad. 

En mi caso solo cambiaría el tiempo que tarda en cerrar la ventana de 

diálogo, para que tarde menos en cerrarse una vez finalizado el cambio. 

 

• Comportamiento de sincronización (Sync Behavior): especifica cómo se 

enviarán las sincronizaciones al telescopio: 

▪ Sync: sincroniza la montura cada vez que se solicita una 

sincronización. Este es el valor predeterminado y debe usarse para 

la mayoría de las monturas. 

▪ Offset: Sincroniza la montura para Solve y Sync, pero para Auto 

Center y Center aquí se calculará un Offset para girar con mayor 

precisión el telescopio. Esto es útil para algunas monturas que no 

desean que las sincronizaciones estén muy juntas. 

▪ None: el montaje no se sincronizará bajo ninguna condición. 

 

Consultaremos el manual de nuestra montura para elegir el adecuado. 

Para la mía, una Skywatcher, es la opción Sync 

 

• El tiempo que tarda el telescopio en asentarse después de que se 

completa una rotación. Actualmente, este valor solo se utiliza durante los 

procesos "Autocenter" y "Center here" (esto será esencialmente el retraso 

entre la rotación y la toma de la siguiente imagen). 

• Longitud focal: este es un campo opcional. Si ingresa un valor aquí, el 

encabezado de los FITS "FOCALLEN" se escribirá en sus imágenes de la 

secuencia. 

Telescope Nudge 

En este apartado podemos configurar la velocidad del movimiento de la montura, 

e invertir la dirección N/S o E/W del movimiento de esta. 
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Para modificar estos parámetros es necesario consultar en el manual de nuestra 

montura. Para mi Skywatcher los valores por defecto funcionan perfectamente. 

 

 

Plate Solve 

Usaremos esta pestaña para configurar cómo sincronizar la montura y encontrar 

los objetos a fotografiar. 

 

En “Interface” podemos elegir el método que queramos para resolver el campo 

de nuestras imágenes. En mi caso utilizo PlateSolve2 y pulsaremos en 

“Settings”, y nos abrirá una nueva ventana donde configuraremos el programa. 

Plate Solve es un programa externo de SGP -gratuito- de PlaneWave. 

Necesitamos configurarle el directorio donde están los catálogos que usará para 

resolver el campo de las imágenes.  

Iremos, pues, en la nueva ventana abierta, y como vemos en la siguiente imagen, 

a File → Configure Catalog Directories… . 
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Nos abrirá una nueva ventana en la que elegiremos dónde están instalados los 

catálogos en nuestro ordenador. 

 

Podemos encontrar el catálogo APM en el siguiente enlace de la web de 

planewave: https://planewave.com/downloads/get/105 y el catálogo de 

UCAC3PS en https://planewave.com/downloads/get/107 . 

Este paso en algunas ocasiones falla, no quedando bien guardado el directorio 

de los catálogos, por lo que, al cerrar, entraremos de nuevo para comprobar que 

quede guardada la configuración. 

Podemos cerrar, pues, la ventana de Planewave, y continuamos con la 

configuración de Plate Solve Options. 

En “Search” podemos indicar el número de regiones máximas a buscar, yo suelo 

dejarlo en “Max Regions”. 

https://planewave.com/downloads/get/105
https://planewave.com/downloads/get/107
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Binning nos permite elegir el que usaremos en nuestras fotos para resolver el 

campo, y Exposure el tiempo de exposición de nuestra cámara para realizar el 

plate solve. 

Ahora en “Attempt to center” tenemos los intentos que queremos que haga SGP. 

Si solo ponemos 3, si falla tras 3 intentos parará la secuencia. Normalmente si lo 

hemos hecho bien suele resolverlo al primer intento. 

En esta opción podemos añadir en “until error is less than” el margen de error en 

píxels. Yo lo dejo por defecto 50 y por último en “and rotator error is less than” si 

queremos rotar la imagen. Aquí le indicaremos el margen de error en grados   (+/-

). El parámetro de 3,0 funciona bien. 

Nota: si en el Target de nuestra secuencia no está marcado la opción Rotate, 

planet solve no utilizará el margen de error de rotación indicado en la opción 

anterior. 

La opción “Use filter” nos permite elegir con que filtro realizar el plate solve. Yo 

uso siempre el de luminancia ya que necesita menos tiempo de exposición para 

poder obtener una buena imagen para resolver el campo rápidamente. 

Y por último, “use Blind solve failover” nos permite cuando falla el plate solve, si 

disponemos de internet en nuestro sitio de captura (como en un observatorio 

remoto), resolver o hacer el plate Solve con Astrometry.NET.  

Cuando no disponemos de internet podemos elegir la opción ANSVR (Local 

Astrometry.NET) pero tendríamos que tenerla instalada en nuestro pc.  

NOTA IMPORTANTE: Para que SGP y PLATESOLVE2 realicen bien la 

resolución de campo de nuestra imagen, en el EQMOD de nuestra montura 

Skywatcher debemos tener seleccionado en Alinear/sync→Interfaz la opción 

Diálogo, por el contrario, nos dará problemas y no resolverá el campo. 

 

Auto Guide 

En esta pestaña configuraremos nuestro autoguiado. Tenemos varias opciones, 

desde sin guiado a varios programas de auto guiado. En la siguiente imagen 

comparto mi configuración básica: 
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En mi caso utilizo el software externo a SGP, llamado PHD2. Podemos descargar 

la última versión desde https://openphdguiding.org/downloads/. 

Para elegir el programa de auto guiado, desplegaremos la lista donde pone 

“Interface” y pulsaremos en “Settings”. 

 

 

Desde “Browse”, buscaremos la carpeta en nuestro disco duro donde hemos 

instalado el programa, por ejemplo C:/PHD2. 

En “PHD Equipament Profiles” debemos seleccionar el perfil de equipo que 

tengamos configurado en PHD2. Este debemos crearlo antes de configurarlo 

aquí. 

https://openphdguiding.org/downloads/
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Crear un perfil en PHD2 es muy sencillo y usaremos el asistente que lleva el 

mismo, donde nos pedirá el telescopio guía que tenemos, la cámara de guiado 

etc. Aquí tenéis el manual de PHD2 en castellano: 
https://openphdguiding.org/PHD2_User_Guide-es.pdf. 

El resto de las opciones las dejamos marcadas como viene en la imagen y 

pulsaremos ok para volver a la pantalla anterior. 

Nota: Importante para que funcione el PHD2 con el SGP. En el menú de PHD2 

debes tener habilitado el servidor. Podemos hacerlo desde Herramientas 

→Habilitar Servidor. 

Dither 

En astrofotografía, dither significa cambiar ligeramente la orientación del 

telescopio en direcciones aleatorias entre exposiciones. Esto permite que los 

píxeles fríos y calientes, los artefactos de rayos cósmicos y el ruido de patrones 

fijos, e incluso los rastros de satélites o aviones, se eliminen durante el proceso 

de apilamiento.  

Una vez explicado qué es, aquí cada uno puede seleccionar los parámetros que 

mejor le convengan. Yo utilizo para mi equipo small dither, en todas las 

imágenes. 

SGP permite seleccionar entre small, médium, hight, very hight y extreme dither. 

Normalmente con cualquiera de las 3 primeras debería ser suficiente; además 

podemos indicarle cada cuántas imágenes queremos aplicarlo. 

 

Settle 

Justo a continuación de dither aparece: 

 

Esta opción del SGP viene a decir que si el error de guiado no baja de X píxels 

durante X segundos no continuará con la siguiente imagen. Esta opción viene 

muy bien para evitar tomar imágenes cuando el guiado tiene un error muy alto. 

Esta operación la realiza después de realizar el Dither.. 

El resto de opciones por orden: 

• Parar el auto guiado cuando termine la secuencia. 

• Parar el auto guiado mientras espera para el siguiente objetivo. 

• Pausar el guiado durante el autoenfoque. 

• Realizar el Settle del auto guiado antes que el autoenfoque (se usa para 

combinación de OAG + telescopios SC con focales largas). 

• Pausar el guiado durante la descarga de la imagen 

https://openphdguiding.org/PHD2_User_Guide-es.pdf
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• Pausar el guiado durante la backlash comp (OAG). Se usa para prevenir 

errores de estrella perdida del PHD2 para aquellos que usan backlash 

comp (OAG). 

• Reiniciar la imagen actual cuando la distancia de guiado sea superior a X 

píxels. 

• Recalibrar el auto guiado si cambias de objetivo. Esta opción fuerza el 

recalibrado de PHD2. 

 

Other 

En esta pestaña podemos configurar: 

 

• Nuestra caja de Flats. 

• Nuestro rotador de campo. 

• Nuestro observatorio (cúpulas, techos etc.). 

• Nuestro monitor de seguridad. Ofrece 2 estados: seguro o inseguro. Si 

envía inseguro a SGP este inicia el fin de nuestra secuencia y los 

parámetros que hubiésemos configurado anteriormente como aparcado 

etc. 

• Dispositivos de monitoring. 

• Variables. 

En este manual solo mencionaremos la parte del Rotador. La gran mayoría no 

disponemos de este instrumento automatizado, pero lo dejaremos configurado 

como Manual Rotator. 

Muchos telescopios llevan rotador manual, o bien podemos rotar nosotros la 

cámara.  

Si en nuestro perfil ponemos que disponemos de rotador manual, cuando 

creemos una secuencia y dejemos marcado en “Target” la opción “Rotate”, tras 

el plate solve en la secuencia SGP mostrará una ventana nueva con el error de 

rotación de nuestra imagen. 

Después procederemos a rotar manualmente la cámara y le daremos a aceptar. 

Podremos realizarlo tantas veces como lo tengamos configurado en la pestaña 
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Plate Solve en “Attempt to center” y nos dará por bueno el plate solve si tenemos 

un error por debajo del que hemos indicado en “and rotator error is less than”. 

 

File naming Pattern 

Por último, antes de guardar la secuencia, podemos indicarle a SGP cómo 

queremos que se llamen nuestras imágenes. Para ello volvemos al lado derecho 

como vemos en la siguiente imagen.  

 

Si pulsamos sobre la tecla “Key” vemos los diferentes comandos y qué añade 

cada uno al nombre de nuestra imagen: 

 

Una configuración por ejemplo podría ser: %tn_%ft_%fe_%el_%ct_%bi_%fn 

que sería: \\M42_Light_Lum_0sec_NA_1x1_frame1.<ext>. 
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Se pueden separar las imágenes por carpetas según cada filtro, por ejemplo, con 

la siguiente opción: \%fe\%tn_%ft_%fe_%el_%ct_%bi_%fn dando como 

resultando: \\Lum\M42_Light_Lum_0sec_NA_1x1_frame1.<ext> 

Si este es nuestro perfil predeterminado marcaremos el check: 

 

Para finalizar y guardar seguiremos lo indicado en la página 26. En este caso 

como es un perfil nuevo, le daremos un nombre y le daremos a “Save” para 

guardar nuestro perfil. 

 

 

 

4.-Opciones de secuencia (Auto recovery) 

Continuamos configurando nuestro SGP.Esta opción personalmente me gusta 

mucho, y por este motivo la incluyo en este manual “básico”. 

Muchas veces cuando estamos realizando nuestra secuencia de imágenes, 

aparecen nubes que la pueden arruinar. Con esta opción si la dejamos activada, 

cuando nuestra secuencia falle por cualquier motivo, SGP intentará reiniciarla 

pasado un tiempo. 

Para ello iremos a nuestra barra de menús Tools→Options. Aquí encontramos 

varias opciones como el idioma, directorio de los perfiles, nivel del auto estirado 

para ver las imágenes, etc.  

A nosotros nos interesa la pestaña Sequence Options, y donde pone Sequence 

Recovery, habilitaremos la opción “Attempt to automatically recover the 

sequence”, y ponemos lo que nos interesa (los valores por defecto suelen 

funcionar bien). 

Por tanto, si dejo desatendido el equipo, por ejemplo, para irme a cenar y tengo 

la mala fortuna que pasa una nube, SGP perderá la estrella de guiado y parará 

file://///Lum/M42_Light_Lum_0sec_NA_1x1_frame1.%3cext
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la secuencia. Automáticamente abrirá una ventana nueva de auto recovery y 

pasado el tiempo en minutos indicado, hasta un máximo de tiempo que  hayamos 

fijado, intentará reiniciar la secuencia. 

Existen más opciones aquí, pero para nuestra configuración básica no será 

necesario profundizar en ellas. 

 

 

Finalmente le damos a ok y se cerrará la ventana quedando configurado. 

 

5.-Preparando Nuestra Secuencia  

Tenemos dos formas de preparar el objeto que queremos fotografiar: desde la 

propia secuencia en el bloque de “Target” u objetivo en castellano, o desde la 

herramienta Framing & Mosaic Wizard. 

5.1.-Desde Target 

Para añadir un objetivo, usaremos como referencia el punto 2.5 de este manual. 

Al añadirlo se agrega como Target 1,2,3 etc. Si nos situamos encima y pulsamos 

sobre la tuerca que aparece, podemos configurar el Objeto a fotografiar. 

Debemos cambiarle el nombre al que nosotros queramos, normalmente el 

nombre del objeto a fotografiar 

Ahora vamos a darle nosotros las coordenadas del centro del objeto en la opción 

“Location (J2000)” o, por el contrario, si disponemos de internet, mediante 

enlaces de servicios como Astrobin, Telescopius o Flickr, SGP calculará el 

encuadre y nos pondrá automáticamente las coordenadas y la rotación de la 

cámara. 

Para que SGP realice la resolución de campo y nos deje el objeto centrado en 

las coordenadas indicadas, debemos seleccionar “SLEW to and then CENTER 

on location” 
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La opción “Time Constraints” es opcional y sirve para planificar la hora a la que 

empezar la secuencia y la hora de finalización, e incluso hacerlo por la altura en 

grados del objeto a fotografiar 

 

Si tenemos configuradas nuestras coordenadas en “User profile manager” (pág. 

24), podremos utilizar la herramienta “Planning tools”, con la que aparecerán en 

una gráfica las horas de noche y altura de nuestro objeto.  
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En ella podemos poner el inicio de nuestra secuencio pulsando en la gráfica en 

con el botón izquierdo del ratón en la hora que queremos empezar, y el fin de la 

misma con el botón izquierdo del ratón en la hora de finalización de la secuencia. 

Para finalizar la configuración de nuestro objeto, en “Other” marcaremos “Rotate 

camera to” si deseamos un encuadre concreto. SGP cuando resuelva el campo 

comprobará que la orientación de la cámara es la correcta antes de continuar 

con la secuencia. 

Pulsaremos Ok y se cerrará la ventana volviendo a nuestra secuencia. 

Faltaría cumplimentar en el bloque de eventos y el boque de datos -como hemos 

aprendido en la pag.16 a la 20- las tomas que queremos realizar, la carpeta 

donde queremos guardar, el perfil de usuario, etc. 

Antes de pulsar sobre run sequence, nos aseguraremos de que estamos usando 

el “Equipment profile” correcto. SGP al abrir carga el perfil por defecto. Si 

queremos cambiarlo o volver a aplicarlo tras un cambio en el mismo, iremos a 

File→Apply Profile To Sequence, saldrá una lista con nuestros perfiles de 

equipamiento y seleccionaremos el que tengamos que usar en nuestra 

secuencia. 

 

 

¡Ya podemos lanzar nuestra secuencia cuando estemos con el telescopio 

montado! Pulsaremos para ello “Run Sequence”.  
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5.2.-Desde Framing & Mosaic Wizard 

Hemos visto cómo preparar el objeto que queremos fotografiar manualmente. 

SGP tiene una herramienta para preparar encuadres y mosaicos. Nosotros la 

vamos a utilizar desde casa, o donde dispongamos de internet para buscar 

nuestro objeto y encontrar el encuadre que nos guste más. 

Esta herramienta está en nuestra barra de menús Tools→Framing & Mosaic 

Wizard o Cntrl + M. Aunque nos permite hacer mosaicos, si elegimos únicamente 

una tesela nos sirve para fotografía normal. 

 

Nos abrirá una ventana nueva como la que vemos arriba. Antes de empezar, en 

el menú de la nueva ventana en “Profile” elegiremos el perfil de equipamiento 
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que vamos a usar. De esta forma nos saldrá la simulación del campo que vamos 

a fotografiar de forma correcta. 

1. Definir el objeto y el campo a mostrar. 

• Object: ponemos el objeto o la url de Astrobin, etc 

• Image: si preferimos una imagen del objeto que ya tenemos en el disco 

duro. 

• RA/DEC: introduciremos las coordenadas manualmente 

• FOV: tamaño del campo que queremos que muestre SGP en grados. 

2. Datos de la cámara: si hemos cumplimentado bien nuestro “equipment 

profile” no tocaremos esta opción. 

3. Define el objeto: seleccionaremos “Draw the target rectangle”. Para dibujar 

un rectángulo en el objeto que mostrará, siendo el interior de este lo que 

quedará fotografiado en nuestra secuencia. Podemos rotar la imagen con 

“Rotate selection” de 0 a 360º para buscar el mejor encuadre.  

4. Número de teselas: como no vamos a hacer un mosaico, cuando tengamos 

hecho el recuadro anterior, aquí nos aseguraremos de que en “Camera tiles” 

sea 1x1. 

Vamos a ello. Buscamos, por ejemplo, Messier 42 o M42. Ponemos M42 en 

Object y pulsamos en Fetch. 

 

 

Aparecerá al rato el objeto con el campo que le hemos dado en FOV. Si es 

demasiado alejado bajaremos el número de FOV; si es demasiado pequeño 

subiremos el FOV y le daremos a Fetch de nuevo para aplicar los cambios 
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Ahora con el ratón dibujaremos un rectángulo de lo que queremos fotografiar, si 

resulta más grande de lo que puede nuestro sensor nos pondrá varios recuadros. 

En ese caso en el punto 4 asegúrate de poner 1 x 1. 

Giraremos la imagen desde el punto 3 en “Rotate Selection” y buscaremos 

nuestro encuadre óptimo. 

 

Para finalizar, pulsaremos sobre Create Sequence y se abrirá una ventana 

nueva. 

 

Igual que en la ventana de Target, si lo hiciéramos manualmente debemos 

ponerle un nombre a nuestro objetivo, en Name. 

Dejaremos “Append targets to sequence" seleccionado si queremos agregar este 

objeto a la lista de objetos de nuestra secuencia. Por el contrario, si deseamos 

eliminar los objetos de la secuencia activa, podemos darle a “Replace targets in 



 

 
 

52 

sequence”. Esto eliminará todos nuestros objetos y solo dejará este en la 

secuencia. 

Debemos marcar “SLEW to and then CENTER on location” si queremos que 

resuelva el campo. Si queremos rotar la cámara para dejar el encuadre deseado 

dejamos marcado “Rotate or validate camera angle”. 

En caso de dejar marcado “Associate working image with sequence”,  guardará 

los datos y se abrirá cada vez que abras la secuencia para una futura referencia, 

por ejemplo, al trabajar con mosaicos (opcional). 

Por último, le damos a Ok y nos añadirá el Objeto al bloque de Targets.  

De manera opcional podemos seguir los pasos del punto 5.1 solo si deseamos 

planificar el inicio y el final utilizando la herramienta “Plannig tools” como hemos 

aprendido anteriormente. 

Aplicaremos el “equipment profile” de nuevo a nuestra secuencia si fuera 

necesario y ya podemos darle a “Run Sequence” para el comienzo de esta. 

Nota: Si planificas una secuencia a una hora concreta, si le das a “Run sequence” 

no iniciará la secuencia hasta que llegue dicha hora. 

 

 

6.- Enfoque manual 

Algunos compañeros solo disponen de su cámara DSLR y no disponen de un 

enfocador automático. A continuación, explicaremos una forma de poder enfocar 

mediante SGP de forma manual. 

En “Equipament Profile” deberemos marcar en “Focuser” la opción “No Focuser”. 

 

Para un enfoque manual correcto es recomendable disponer al menos de una 

máscara Bahtinov.  

Para poder realizar este enfoque, debemos llevar nuestro telescopio a una 

estrella. Como este no está enfocado, esto puede ser un problema, ya que no 

dispondremos de la utilidad de “Plate Solve”. Además, en nuestro “set up” de 

astrofotografía es más que probable que no dispongamos de buscador, para 

aligerar el peso de la montura. 

A continuación, detallo el método que utilizaba para realizar un enfoque preciso 

manualmente: 

En nuestra secuencia, ya preparada, tendremos en el bloque “Equipment” una 

configuración parecida a la siguiente: 
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Como vemos en la imagen anterior, ya tengo conectada la cámara y la montura.  

Para no tener que modificar nuestro target y apuntar a una estrella, en mi caso 

utilizo el Stellarium para mover el telescopio a la estrella y así poder realizar el 

enfoque. Cualquier software de planetario celeste desde el que se pueda mover 

el telescopio nos puede servir. Recuerda: si usas varios programas a la vez -

como es el caso-, en lugar del usar el driver Ascom de la montura, debes usar el 

Poth Hub de Ascom. 

Si necesitas más información sobre el POTH HUB de Ascom, puedes encontrarla 

aquí http://astrocosmos.com.es/poth-plain-old-telescope-handset/?i=1 . 

Si hemos realizado una puesta en estación exquisita, nuestra estrella quedará 

dentro del campo del telescopio.  

Procedemos, pues, a usar el módulo de SGP “Frame And Focus”: 

 

• Podemos variar el bining de nuestra cámara para descargar más rápidamente 

las imágenes al ordenador.  

• Variar las exposiciones de las tomas de enfoque para poder ver bien las 

estrellas y enfocar correctamente.  

• Tomar una sola foto  

• Por último, la más interesante, podemos tomar fotos en bucle mientras 

manipulamos el enfocador del telescopio para conseguir el enfoque perfecto. 

El botón Start se muestra así   cuando tenemos paradas las tomas. 

Si pulsamos en él comenzará la captura continua de imágenes. Y aparece 

como Stop  cuando el proceso de captura continua está en marcha. 

Pulsando en él pararemos el proceso. 

http://astrocosmos.com.es/poth-plain-old-telescope-handset/?i=1
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Utilizaremos este módulo para realizar las tomas continuas, hasta que tengamos 

correctamente enfocada nuestra estrella. Solo entonces podremos iniciar la 

secuencia normalmente.  

NOTA: Este software es una auténtica maravilla para automatizar todo el proceso 

tanto de enfoque, encuadres y captura de imágenes. Por ello, es recomendable 

disponer de un enfocador automático: obtendremos enfoques más precisos en 

la mitad de tiempo. ¡El tiempo en esta afición es oro! 

 

7.- Calibrado de Flats (Calibration Flats Wizard). 

SGP tiene una herramienta muy potente para calibrar los Flats, llamada Flats 

Calibration Wizard. La podemos encontrar en Tools→ Flats Calibration Wizard 

 

1. Seleccionamos el perfil desde “Choose”. Ahí tenemos nuestros perfiles de 

equipo, y elegimos con el que vamos a trabajar 

2. Seleccionamos los filtros y el binning donde queremos calibrar los flats. 

Aparecerá en forma de listado donde marcaremos las casillas 

correspondientes. Ejemplo Lum bin 1x1, R bin 1x1, G bin 1x1, B bin 1x1. 
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3. Podemos dejar por defecto los ADU y el tiempo de exposición para que lo 

calcule el SGP. Si por el contrario queremos modificar algún parámetro lo 

podemos hacer desde aquí. 

Pulsamos sobre Start y cuando termine Save. 

Cuando en nuestra secuencia pongamos los Flats nos habrá guardado el tiempo 

de exposición necesario para cada flat de cada filtro. 

Por tanto, solo debemos cumplimentar las tomas que queremos de flats en 

nuestra secuencia y SGP pondrá la exposición automáticamente. 

 

 

 

Nota: Tenga en cuenta que esta herramienta elimina cualquier secuencia que 

tenga activa. ¡Recuerde guardarla antes! 

 

Y eso es todo. Esperamos que la guía os haya sido de utilidad. Ahora ya solo 

queda practicar...y cielos despejados. ¡Mucha suerte! 


